
    

আারাভুয়ারাইকুভ। ভাইক্রাপট ওয়ার্ড-০৭ Tutorial টটক্ে আনাক্ক স্বাগেভ। আনাযা মাযা 

ভাইক্রাপট ওয়ার্ড-০৭ টখক্ে চান োক্েয জনয ফইটট খুফই গুরুত্বূ্ড বফ  ফইটটক্ে খুফ জ 

কক্য ওয়ার্ড বয কাজ গুক্রা টনক্য় টচত্র আক্রাচনা কযা ক্য়ক্ছ, আা কটয ফইটট আনাক্েয বাক্রা 

রাগক্ফ। ফইটট ক্ে আনাক্েয টফনু্দভাত্র উকায ক্র আভায টযশ্রভ ার্ডক ক্ফ। আযও ফই 

পক্ে আটন আভায ব্লগ পেখক্ে াক্যন- http://hiractg.blogspot.com 

ভাইনুর ক টযা 

ই-পভইরঃ hira_ctg28@yahoo.com 

ওক্য়ফাইটঃ http://hiractg.blogspot.com 

আনায ুটফধায জনয টনক্চ ইনক্র্ক্স বয ভে ফইক্য়য ভূর Topics গুরা পেওয়া র বফ  আটন 

পমই Topics ব পমক্ে চান পই Topics বয উয টিক কযক্র আটন পখাক্ন চক্র মাক্ফন। 

(বখাক্ন ফ topics পেওয়া য় নাই শুধু Important topics পেওয়া র)   

Topics 

 Introduction 

 Home Tab 

a) Font Menu – MS Word keyboard Shortcut 

b) Paragraph related Toolbar 

c) Styles Tool 

d) Clipboard & Editing 

 Page Layout Tab 

a) Themes Menu 

b) Page Setup Menu 
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c) Page Background 

d) Paragraph section 

 View Tab 

a) Zoom Menu 

b) Window Menu 

 Insert Tab(Most Important) 

a) Create New Page 

b) Create cover page 

c) Create Table 

d) Insert Picture & Picture Editing 

e) Clip Art 

f) Text Toolbar 

g) Word Art 

h) Header & Footer Menu 

i) Create Logo With Shape & Word Art 

j) Equation Menu 

k) Chart Menu 

l) Smart Art Menu 

শুরু কযা মাক োক্র...  

Microsoft বয Office package টা আক্রই Complete বকটা package। মায ভাধযক্ভ প্রায় 
ফ ধযক্নয অটপটয়ার ফা দেনটন্দন কাজ কযা মায়। আনায মাযা ওয়ার্ড াক্যন োযা জাক্নন পম, 
ওয়ার্ড ফযফায কক্য ওক্য়ফাইট দেযী কযা মায়। বছাোও logo, poster, banner, visiting 
card ইেযাটে design কযা মায়। ুন্দয ুন্দয Report দেযী কযা মায়, পমখাক্ন আটন আনায 
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ইচ্ছাভে Chart, Graphics বগুক্রা  ক্মাজন কযক্ে াযক্ফন বফ  আযও কে টক।বই 
টটউক্টাটযয়ারটা নেুন ফা মাযা ওয়ার্ড জাক্নন োক্েয জনয না। েক্ফ আটভ পচষ্টা কযফ, আনাক্েয 
জানায টবেক্যও, টকছু অজানা ের্য পেয়ায। আয বটা ছাোও আনাক্েয মটে অনয টকছু জানায 
র্াক্ক, োক্র আভাক্ক ইক্ভইর কযক্ে াক্যন। োক্র আুন আয কর্া না ফাটেক্য়, শুরু কটয।  

আয বকটট কর্া MS Word-07 বফ  MS Word-10 প্রায় বকই ধযক্নয ইন্টাযক্প, বই কাযক্ন 
মাযা MS Word-07 বার াযক্ফন োযা MS Word-10 ও াযক্ফন।  

প্রর্ক্ভ ওয়ার্ড run করুন। োক্র বযকভ বকটট Screen পেখক্ে াক্ফন। 

 

ছটফক্ে পম টুরফাযগুক্রা পেখক্ছন Home Tab ফা Home Menu বয Underব বগুক্রা ফই খুফই 
েযকাযী। বখাক্ন পম টুরফায গুক্রা আক্ছ বগুক্রা ফযফায কক্যই আটন ওয়ার্ড-বয প্রায় প্রক্য়াজনীয় 
ফ কাজই কযক্ে াযক্ফন। োই আভযা প্রর্ক্ভই বই টুর গুক্রা ফযফায কযা টখফ। 
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আটভ বখাক্ন প্রর্ক্ভ কর টুরফায গুক্রায ছটফ টেফ োযয টনক্ছ ফগুক্রা টনক্য় ফ্ডনা ফা বয 
কাজ গুক্রা পেখাফ। 
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বখাক্ন আভাক্েয ফক্চক্য় প্রক্য়াজনীয় টুর ক্রা Font োযয Paragraph, Clipboard, 
Editing বফ  ফক্ক্ল Styles টুরফাযটট। অক্নক্ক অফয আভায াক্র্ বকভে নাও ক্ে াক্যন। hira
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আটন মটে computerব নেুন ন োক্র অফয আনায ভক্ন প্রশ্ন আক্ে াক্য Font টক? 
Font আক্র বক পট ফ্ডভারা। জ বাক্ফ ফরা মায়, ধরুন আনায ৩জন ফনু্ধ আক্ছ – টযা, 
আযভান, আটপ। োক্র আভযা াধায্ে বটা ফরক্ে াটয পম, আনায ৩ ফনু্ধয াক্েয পরখা ৩ 
যকভ। কাক্যাযটা পেখক্ে খাযা, আফায কাক্যাযটা পেখক্ে বার, আফায কাক্যাযটা অক্নক পচাক্না 
অর্ডাৎ বক্ককজক্নযটা বক্কক ধযক্নয ুন্দয। আনায মটে টযায াক্েয পরখা বাক্রা রাক্গ, 
োক্র আটন টক কযক্ফন প্রক্য়াজনীয় পকান টকছু পরখায ভয় টযাক্ক ফরক্ফন, ফনু্ধ আভাক্ক বইটা 
বকটু টরক্খ োও। আভযা font পক আক্র বক বকজক্নয াক্েয পরখায াক্র্ েুরনা কযক্ে 
াটয। কটিউটাক্য টফটবন্ন ধযক্নয font ফা াক্েয পরখা, আনায পম fontটট বার রাগক্ফ, আটন 
পই font টট ফযফায কযক্ফন। 
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প্রর্ক্ভই Fonts toolbar টটয ফযফায পজক্ন টনই। বখাক্ন আনাযা টফটবন্ন টুর বয আইকক্নয 
টেক্ক রক্ষ কযক্রন পেখক্ফন icon গুক্রা োক্েয ফযফায অনুমায়ী টর্জাইন কযা ক্য়ক্ছ। পমভন 
Bold বয icon টায B বকটু পভাটা যক্প পরখা আক্ছ, Italic আইকক্নয I টা র্ানটেক্ক কাে 
কযা, ববাক্ফ আনাযা আইকন পেক্খই ফুঝক্ে াযক্ফন ঐ Tools বয কাজ টক ইেযাটে। 
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ছন্দ অনুমায়ী Font টনফডাচন করুন। 
পন্ট াইজ পছাট ফা ফে করুন। 
পন্টক্ক পফাল্ট ফা াইরাইট করুন। 
পন্টক্ক ইটাটরক ফা র্ানটেক্ক ারকা কাে কক্য টেন। 

 

পন্টক্ক আন্ডাযরাইন করুন। 
পন্ট বয ভাঝফযাফয োগ টেন। 
পন্টক্ক Subscript ফা H2O বই বাক্ফ টরখুন। 
পন্টক্ক Superscript ফা X2 ববাক্ফ টরখুন। 
টফটবন্ন ব্দক্ক ফে াক্েয ফা পছাট াক্েয অক্ষক্য টয্ে করুন। 
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বেক্ষ্ আভযা মা মা টরখরাভ পটা Save কযক্ে জাক্নন পো, না জানক্র ভযা পনই আুন 
টকবাক্ফ Save কযক্ে য় ো পেক্খ টনই। 

 
 
ছটফক্ে পেখাক্না স্থাক্ন টিক করুন অর্ফা ফক্চক্য় জ দ্ধটে টক-পফার্ড পর্ক্ক Ctrl বফ  S 
বকাক্র্ চা টেন। 

 
 
োযয বকটট File Name টেন ও Save ব Click করুন। বকাক্র্ চা পেয়াক্ক াধায্ে (ctrl 
+ S) ববাক্ফ প্রকা কযা য়। টকক্ফার্ড কভান্ড ভক্ন যাখায জ দ্ধটে র, আটন পম কাজটট 
কযক্ে চান োয প্রর্ভ অক্ষয বফ  াক্র্ Ctrl চাক্ে ক্ফ। আটন ওয়ার্ড ওক্ন কক্য keyboard 
পর্ক্ক Alt পপ্র করুন আটন টনক্চয ছটফয ভে পেখক্ফন  
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উক্যয ছটফ পর্ক্ক আভযা পেখক্েটছ আভযা মখন ওয়াক্র্ড Alt পপ্র কটয েখন প োয ফ Alt 
টডকাট পেখাই, বখন আভযা পমভন Alt+H পপ্র কযক্র Home tab চক্র আক্ফ আটন পেখুন 
আক্ টকনা? ফাটকগুরা োক্র ফুঝক্েই াযক্ছন। বখন আফায আভযা Alt+N (Insert Men) পপ্র 
কযক্র টনক্চয ভে পেখাক্ফ  

 

উক্যয ছটফক্ে Insert Menu ফ টডকাট আক্ছ আটন শুধু Alt+(আনায কাটিে key) পপ্র 
কযক্র ক্ফ। বকটা টজটন পখয়ার যাখক্ফন Alt+N বফ  Ctrl+N বকই টজটন নই! আভযা উক্য 
Alt+N বয ফযফায পেক্খটছ বখন পেখফ Ctrl+N পমভন আটন মটে বকটট New file খুরক্ে চান 
োক্র টকক্ফার্ড কভান্ড টক ওয়া উটচৎ, যা আটন টিক ধক্যক্ছন Ctrl+N বফায Ctrl  রান্ত  
আক্যা টকছু টকক্ফার্ড কভান্ড টনক্চ পেয়া রঃ  
 

 Common tasks in Microsoft Office Word 

To do this Press 
Create a nonbreaking space. CTRL+SHIFT+SPACEBAR 
Create a nonbreaking hyphen. CTRL+HYPHEN 
Make letters bold. CTRL+B 
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Make letters italic. CTRL+I 
Make letters underline. CTRL+U 
Decrease font size one value. CTRL+SHIFT+< 
Increase font size one value. CTRL+SHIFT+> 
Decrease font size 1 point. CTRL+[ 
Increase font size 1 point. CTRL+] 
Remove paragraph or character formatting. CTRL+SPACEBAR 
Copy the selected text or object. CTRL+C 
Cut the selected text or object. CTRL+X 
Paste text or an object. CTRL+V 
Paste special CTRL+ALT+V 
Paste formatting only CTRL+SHIFT+V 
Undo the last action. CTRL+Z 
Redo the last action. CTRL+Y 
Open the Word Count dialog box. CTRL+SHIFT+G 
 

 Create, view, and save documents 

To do this Press 
Create a new document of the same type as the current or 
most recent document. 

CTRL+N 

Open a document. CTRL+O 
Close a document. CTRL+W 
Split the document window. ALT+CTRL+S 
Remove the document window split. ALT+SHIFT+C 
Save a document. CTRL+S 
 

 Find, replace, and browse through text 
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To do this Press 
Find text, formatting, and special items. CTRL+F 
Repeat find (after closing Find and Replace window). ALT+CTRL+Y 
Replace text, specific formatting, and special items. CTRL+H 
Go to a page, bookmark, footnote, table, comment, 
graphic, or other location. 

CTRL+G 

Switch between the last four places that you have 
edited. 

ALT+CTRL+Z 

Open a list of browse options. Press the arrow keys to 
select an option, and then press ENTER to browse 
through a document by using the selected option. 

ALT+CTRL+HOME 

Move to the previous edit location. CTRL+PAGE UP 
Move to the next edit location. CTRL+PAGE DOWN 

েক্ফ ভভয়ই পম বই পটকটনক কাক্জ রাগক্ফ, ো ফরটছ না েক্ফ অটধকা  ভয়ই বটা কাক্জ 
রাগক্ফ। শুধু ভাইক্রাপট ওয়াক্র্ড না পম পকান পটওয়যায ব টকক্ফার্ড কভান্ডগুক্রা ববাক্ফ পট 
কযা।  

ওয়ার্ড কাজ কযায ভয় বকটা কর্া ফভয় ভক্ন যাখক্ে য় আয পটা র টক্রক্ট কযা। আটন 
পম অ টুকু টনক্য় কাজ কযক্ছন, পই অ ক্ পকান টযফেডন চাইক্র আনাক্ক অফযই পই 
অ টুকু টক্রক্ট কযক্ে ক্ফ। অক্নক ভয় পেখক্ফন আটন পকান বকটট পরখা য়ে Bold কযক্ে 
চাইক্ছন, টকন্তু ক্চ্ছনা কায্ টকন্তু বকটাই আটন পম অ টুকু পফাল্ড কযক্ে চাইক্ছন ো টিকবাক্ফ 
টক্রক্ট কক্যনটন। ধরুন, আটন টরখক্ে চাক্চ্ছন Bangladesh is my motherland – বয টবেক্য 
Bangladesh কর্াটট Bold ক্ফ, পক্ক্ষক্ত্র অফযই আনাক্ক Bangladesh ব্দটা ভাউ টেক্য় 
টক্রক্ট কক্য টনক্ে ক্ফ। আভযা Home Tab বয Underবয Paragraph related toolbar বয 
াক্র্ টযটচে ফ। ছটফ রক্ষয করুন 
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উক্যয ছটফক্ে পকান টুর বয টক নাভ ো ফই পেয়া আক্ছ। বখন টনক্চ বই টুরগুক্রায কাজ 
টক ও টকবাক্ফ ফযফায কযক্ে য় ো পেয়া র। বকটা কর্া আক্গও ফরটছ বখন আফাক্যা ফরটছ, 
আনাযা মটে টফটবন্ন টুর বয Icon গুক্রায টেক্ক পখয়ার কক্যন োক্র পেখক্ে াক্ফন পম, 
আইক্কান বভনবাক্ফ দেযী কযা ক্য়ক্ছ, মাক্ে আটন icon পেখক্রই ঐ টুর বয কাজগুক্রা ফুঝক্ে 
াক্যন। উক্যয ছটফয ফুক্রট ক্য়ক্ন্টয আইকন বারবাক্ফ পেখুন োক্র পেখক্ফন প্রর্ভ আইকক্ন 
৩টা পপাটা পেয়া োযয ৩টা রাইন আক্ছ, োয অর্ড আভযা মটে পকান রাইন পকান টফক্ল টচহ্ন 
দ্বাযা টরখক্ে চাই। আফায Alignment আইকক্ন পেখুন বকটায ফাভা ভান, বকটায র্ানা 
ভান আয টভর্র বযারাইনক্ভক্ন্ট রাইন বয েুই াক্ ভটযভান পাকা জায়গা র্াক্ক। 

Bullet Point: পকান টফক্ল টচহ্ন দ্বাযা পকান ফাকয টরখক্ে চাইক্র ফা ক্য়ন্ট আকাক্য পকান ফাকয 
টরখক্ে ক্র। Bullet point ফযফায কযা মায়। নাম্বায দ্বাযাও ফুক্রট ক্য়ক্ন্ট পেয়া মায়। বটা 
ফযফায কযায জনয প্রর্ক্ভ বই আইকক্ন টিক কযক্ে য়, প্রর্ভ রাইন পক্ল Enter চা টেক্র 
যফেডী রাইন ও ফুক্রট ক্য়ন্ট টেক্য় শুরু ক্ফ। আয যয ২ ফায Enter press কযক্র। ফুক্রট 
ক্য়ন্ট পল ক্য় মায়। আফায ফুক্রট ক্য়ক্ন্টয পরখায ভক্ধয মটে ফুক্রট ছাো পকান রাইন টরখক্ে 
য়, োক্র াধায্ে Shift+Enter বকাক্র্ চাক্ে য়। hira

ctg
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Indent: ুক্যা para ধক্য র্াক্ন অর্ফা ফাক্ভ যাক্নায জনয ফযফহৃে য়। 

Alignment: র্াক্ন, ফাক্ভ ও ভাক্ঝ বযারাইক্ভন্ট কযায জনয ফযফায কযা য়। 

Line & Character spacing: যয েুই রাইন অর্ফা েুইটা ব্দবয ভাক্ঝ কেটুকু পাকা জায়গা 
র্াকক্ফ, ো টনধায্ কযা য়। 
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Background color & Border: প্রর্ক্ভ পম পরখায ফযাকগ্রাউন্ড টযফেডন কযক্ে চান। ো টক্রক্ট 
করুন। োযয কারায টযফেডন কক্য টেন। অনুরূবাক্ফ পরখায Border ও পচঞ্জ কযক্ে াক্যন। 
উোয্ স্বরূ ছটফ রক্ষয কযক্ে াক্যন। 

বফায Clipboard ও Editing বয টুর গুক্রা টনক্য় আক্রাচনা কযফ। বই টুরগুক্রা যাটয 
পরখাক্রটখয পক্ষক্ত্র পেভন বকটা কাক্জ রাক্গনা, টকন্তু আটন মটে বই টুরগুক্রা ুন্দয বাক্ফ ফযফায 
কযক্ে াক্যন োক্র আনাক্েয কাজ অক্নক কক্ভ মাক্ফ। 

 

Cut > বটা টেক্য় াধাযনে পম পকান পরখা বকস্থান পর্ক্ক অনযস্থাক্ন কাট কক্য টনক্য় মাওয়া য়। 
বয টকক্ফার্ড কভান্ড (Ctrl + X)। (অপটটক: বটায টকক্ফার্ড কভান্ড টকন্তু ওয়া উটচৎ টছর Ctrl+C 
টকন্তু ো না ক্য় Ctrl+X ক্য়ক্ছ। মটে ভক্ন র্াক্ক োক্র পেখক্ফন Ctrl+C টকক্ফার্ড কভান্ডটট আক্গই 
Copy েখর কক্য ফক্ আক্ছ। পমক্েু, বকই টকক্ফার্ড কভান্ড ক্ে াক্যনা, োই Ctrl+X ক্য়ক্ছ। 
আফায রক্ষ করুন াধাযনে আভযা কাটাকাটট কাাঁটচ টেক্য় কটয, কাাঁটচ টকন্তু পেখক্ে বকেভ ই যাজী 
অক্ষয X বয ভে পেখক্ে, োই বয টকক্ফার্ড কভান্ড Ctrl+X ক্য়ক্ছ। বাফক্েই অফাক রাক্গ পম, 
টকক্ফার্ড কভান্ডগুক্রা বে ুন্দয system অনুমায়ী ক্য়ক্ছ পম, প্রক্য়াজনীয় টকক্ফার্ড কভান্ড গুক্রা 
বভটনই ভক্ন র্াক্ক। ) hira
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Copy > বটা টেক্য় পম পকান পরখা বকস্থান পর্ক্ক অনয স্থাক্ন Duplicate কযা য়। keyboard 
কভান্ড Ctrl+C 
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Paste > বটা টেক্য় Cut/Copy কযা পকান পরখা পকান টনটেডষ্ট স্থাক্ন Paste ফা যাখা মায়। বয 
টকক্ফার্ড কভান্ড Ctrl+V। (অপটটক: বখাক্ন বয প্রর্ভ অক্ষয P ওয়া ক্েও বয টকক্ফার্ড কভান্ড 
টকন্তু Ctrl+P না কায্ Ctrl+P পে Print নাভক খুফই প্রক্য়াজনীয় টকক্ফার্ড কভান্ড পেয়া আক্ছ। 
পেখুন টকক্ফার্ড বয X, C বয ক্যয অক্ষযটাই V। বটা বক্েয ক্য পেওয়াক্ে আভযা টকক্ফার্ড 
পর্ক্ক আঙু্গর না টযক্য়ই খুফ ক্জ বই অনটা execute কযক্ে াযফ। বটা পেখুন Ctrl+p পে 
পেয়া র্াকক্র আভাক্েয াে উটিক্য় োযয কভান্ডটট টেক্ে ক্ো। টক ইন্টাযটট  না – আভায কাক্ছ 
টকন্তু পছাটখাট ফযাাযগুক্রা খুফই বার রাক্গ। বইফ পর্ক্ক পফাঝা মায় কটিউটায চারাক্না আক্র 
খুফই জ কাজ, আভযা পচষ্টা কটয না োই াটযনা।) 

 
 
Format Painter > বটা টেক্য় পম পকান পরখায Style বক টিক্কই copy কযা মায় পমভন ছটফ 
রক্ষ করুন। 
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Editing tools টাও খুফই প্রক্য়াজনীয়। 
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বটা টেক্য় আভযা খুফ ক্জই পরখায ভক্ধয পর্ক্ক desired word টট খুক্জ পক্ে াটয। আফায 
ইচ্ছা কযক্র বকটা ব্দ টযফেডন কক্য অনয ব্দ ফটক্য় টেক্ে াটয পচাক্খয রক্কই। বয টকক্ফার্ড 
কভান্ড Ctrl+F. 
 

 

 
পমভন আভযা মটে Digital Bangladesh Paragraph টাক্ক টযফেডন কক্য Digital Dhaka পে 
টযফেডন কযক্ে চাই োক্র প্রটেটা ব্দ আরাো আরাো কক্য টযফেডন না কক্য Replace 
option ফযফায কক্য বকফাক্য বফ  পচাক্খয টনটভক্লই কাজটট কযক্ে াটয। hira
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বটাক্ক আক্যা অক্নকবাক্ফ ফযফায কযা মায়। বটা আনাযা পফয করুন। 
 

আভাক্েয বখক্না Styles নাভক টুরটা ফাটক আক্ছ। বটা আক্র খুফই পাজা। ওয়ার্ড ব পম পকান 
টকছু টরখুন, োযয পরখাটট টক্রক্ট কক্য Styles ব মান পেখক্ফন, আনায পরখায পন্ট াইজ, 
কারায ইেযাটে change ক্য় পগক্ছ। 
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বখন আটভ আনাক্েয জনয বকটা practice file টেফ। শুরু পর্ক্ক বখন মডন্ত আনাযা মটে বার 
কক্য Practice কক্যন, োক্র বটা আনাযা অনায়াক্ কযক্ে াযক্ফন। মটে আনাযা ঐ file বয 
কাজগুক্রা বার বাক্ফ কযক্ে াক্যন, োক্র ফুঝক্ফা আনায বারবাক্ফ ফুঝক্ছন। আয মাযা কযক্ে 
াক্যনটন োক্েয আক্র আক্যা practice েযকায। 

প্রর্ক্ভই বখান পর্ক্ক Exercise files টা download কক্য টনন। 
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ছটফয টেক্ক রক্ষ করুন। হুফহু বযকভ পেখক্ে word ব বকটা file দেযী করুন। মটে ভযা না 
য়, োক্র পফাঝা মাক্ফ আটন খুফই বার word াক্যন। 

আয মাক্েয বকটু ভযা ক্চ্ছ োযা বই ছটফটা পেখক্ে াক্যন। বখন আা কটয, আয পকান 
ভযা ক্ফ না। 
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মটে কাক্যা Replace অ টা টনক্য় ভযা য় োক্র োযা বই ছটফটা পেক্খ টনক্ে াক্যন। hira
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ধরুন আনায পকান ফে বকটা যচনা টরখক্ে ক্ফ োক্ে য় ৩০ ফায Bangladesh word টা 
আক্ছ, ইচ্ছা কযক্রই আনাযা ফুটদ্ধ খাটটক্য় বখাক্ন Replace ফযফায কযক্ে াক্যন। য়ে 
আনাযা পরখায ভয় “bd” টরখক্রন, যফেডীক্ে bd, replace কক্য Bangladesh কক্য টেক্রন। 
ববাক্ফ আনাযা অক্নক ভয় ফাাঁচাক্ে াক্যন। বখনও মাযা কযক্ে াযক্ছন না, োক্েয আক্যা পফট 
practice েযকায। বার র্াকক্ফন। 
আয পকান ভযা ক্র, অফযই আভাক্ক জানাক্ফন।  

 

আা কটয আনাযা উক্যয practise টা বাক্রা কযক্ে পক্যক্ছন োক্র বখন আভযা Page 
Layout Tab/Menubar বয tools গুক্রায কাজ পেখফ। বই টযাফ বয Margin, Page size 
printing বয জনয খুফই গুরুত্বূ্ড বই পকনটা বারবাক্ফ পফাঝায পচষ্টা কযক্ফন। বই পভনুয 
প্রায় ফ কাজই পভাটাভুটট জ, আা কটয বকফায প্রাকটট কযক্রই ক্য় মাক্ফ। েক্ফ Columns 
দেটয কযাটা বকটু বার কক্য পেখক্ফন কাযন বয টবেয বকটু জটটরো আক্ছ। করাভ দেটযয 
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কাজটা অফয Table অন ফযফায কক্য খুফ ক্জই কযা মায়। েক্ফ বই টক্টভটা আভযা 
মখন Insert পভনুয কাজ কযফ েখন পেখফ। আভযা অফয Page layout বয ফ অন 
পেখফনা, কাযন টকছু টজটন পো আনাক্েয জনয যাখক্ে ক্ফ। টনক্চয ছটফটা রক্ষ করুন। ওয়ার্ড 
ওক্ন কযক্রই আনাযা বভন পেখক্ে াক্ফন। 

 

ছটফক্ে টফটবন্ন টুরগুক্রা রারকাটর টেক্য় আরাো কক্য পেখাক্না ক্য়ক্ছ। বয ভক্ধয Themes, Page 
setup, Page background, Paragraph বফ  Arrange  নাভক section আক্ছ। আভযা বক্ক 
বক্ক প্রক্য়াজনীয় অনগুক্রা পেখফ। পম অনগুক্রা টনক্য় আটভ আক্রাচনা কযফ না পগুক্রা কষ্ট 
কক্য আনাযা বকটু পেক্খ টনক্ফন। 
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প্রর্ক্ভই আভযা Themes নাভক অনটা পেখফ। বটায আক্র নাভই বয কাজ ফক্র টেক্চ্ছ। 
বটাক্ক আনাযা অক্নকটা Template বয াক্র্ েুরনা কযক্ে াক্যন। আভাক্েয যাযায কারায, 
পন্ট বগুক্রা আক্গ পর্ক্ক আটন define কক্য টেক্ে াযক্ফন, োক্ে Document ফা আনায দেটয 
পাইর বয টবেয Styles, fonts ফটকছু টভক্র Harmony দেটয কযক্ফ। 
 

 
 

বফায ওয়াক্র্ড পম পকান টকছু পরক্খন োযয ছটফক্ে পেখাক্না স্থাক্ন ভাউ ক্য়ন্টায টনক্য় মান আয 
পেক্খন টকবাক্ফ আনায পরখায style change ক্য় মাক্চ্ছ। পমটা ছন্দ য় পটা টক্রক্ট করুন। 
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টর্ভ বয ক্যয tools টাই র page setup বফ  বটা ওয়াক্র্ড টপ্রটন্ট  বয পক্ষক্ত্র খুফই গুরুত্বূ্ড 
বূটভকা ারন কক্য। 

 

বই টুর বয প্রর্ভ অনটা র margin। আভযা খাোয় াধায্ে ফাক্ভ ও উক্যয অ ক্ 
ভাটজডন টেই, োয অর্ড র টনটেডষ্ট টকছু জায়গা আভযা পরখায ভয় কাগক্জয ফাক্ভ ও উক্য পাকা 
যাটখ, মাক্ে কক্য আভাক্েয পরখাটা পেখক্ে ুন্দয পেখায়। আয আভযা কটিউটাক্য মখন ভাটজডন 
টেই , েখন াধাযনে চাযা পর্ক্ক Box margin টেই। 
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 ভাটজডন পেয়ায জনয ভাটজডন ব টিক করুন োযয custom margin ব মান। hira
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আনাযা টনক্জক্েয ইচ্ছাভে ভাটজডন টেক্ে চান েক্ফ ছটফক্ে পেখাক্না ঘক্য, ভানগুক্রা টযফেডন কক্য 
টনন বফ  ফক্ক্ল ok করুন। আা কটয আনাযা ভাটজডন টক বফ  বয কাজ টক ো ফুঝক্ে 
পক্যক্ছন। 
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page orientation টক মটে না পজক্ন র্াকুন েক্ফ, ছটফক্ে রক্ষ করুন। বটট নাভ র portrait 
ভুর্, বই ভুক্র্ র্াকক্র াধাযনে আভযা পমবাক্ফ টপ্রন্ট কটয পবাক্ফই টপ্রন্ট ক্ফ। 
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আয Landscape ভুক্র্ াধাযনে কাগক্জয width পফট বফ  height কভ র্াক্ক, টনক্চয ছটফয 
ভে।  

 

 

আভযা পমবাক্ফ margin টযাক্ফ টগক্য়টছরাভ টিক বকইবাক্ফ margin tab ব মান, োযয paper 
tab ব টিক করুন। বখাক্ন আনায কাগক্জয ভা টেক্ে ক্ফ। বখাক্ন কাগক্জয ভা মাই টেক্ফন 
পই ভাক্য কাগক্জয উয আনায পরখাগুক্রা টপ্রন্ট ক্ফ। hira
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াধায্ে আভযা A4 াইক্জয কাগজ টনক্য় কাজ কটয। আটন মটে কাগক্জয ভা পেন ৮ইটি ফাই 
১০ইটি আয টপ্রন্টায মটে ৮ইটি ফাই ৮ইটিয বকটট কাগজ পেন েক্ফ ফুঝক্েই াযক্ছন টক ক্ফ, 
টক আয ক্ফ টনক্চয পর্ক্ক ২ইটি ফাে ক্ে মাক্ফ। োই ফভয় টপ্রন্টাক্য পম ভাক্য কাগজ র্াকক্ফ 
বখাক্ন পই বকই ভা টেক্ফন। ভা টনক্য় ভযা ক্র Scale ফযফায করুন। 

 

বফায আভযা columns টনক্য় কাজ কযফ, বই টুর গুক্রায ভক্ধয বই অনটা বকটু জটটর। 
অক্নক ভয় পেখা মায় আভাক্েয টফটবন্ন ধযক্নয ভযাগাটজক্নয ভে ২ করাভ ফা ৩ করাক্ভ পরখায 
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প্রক্য়াজন ক্ে। পক্ক্ষক্ত্র আভযা বই অনটা ফযফায কযক্ে াটয। করাভ কযায জনয ছটফক্ে 
পেখাক্না স্থাক্ন মান। 

hira
ctg

.blog
spot.

com



    

hira
ctg

.blog
spot.

com



    

 
 
োক্র বভন পেখক্ে াক্ফন। 
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বখাক্ন পেখুন আক্গ পর্ক্ক টকছু নভুনা দেটয কযা আক্ছ। আনায প্রক্য়াজক্নয াক্র্ মটে নভুনাগুক্রা 
ভযাচ কক্য, োক্র পম পকান বকটা টক্রক্ট করুন অনযর্ায় অনয বকটা অন ছন্দ করুন। 
আনায মটে ৪ করাক্ভয েযকায য় োক্র Number of columns ঘক্য ৪ বটি করুন। 
করাক্ভয ভাক্ঝয পাাঁকা জায়গা কভাক্না ফাোক্নায জনয spacing বয ভান কটভক্য় ফাটেক্য় টেন। আয 
মটে প্রটেটা করাভ বয দেঘডয বকই না চান পক্ক্ষক্ত্র Equal column width পর্ক্ক টটক টা উটিক্য় 
টেন। 

 

 
বখান আফায ছটফক্ে পেখাক্না স্থাক্ন অর্ডাৎ ১ভ যাযায পক্ল cursor যাখুন োযয 
Break > continuous ব মান। 
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োক্র বযকভ বকটা োগ পেখক্ে াক্ফন, বই োগ পকন টেরাভ, বকটু ক্যই জানক্ে াযক্ফন। 
েক্ফ, বই dotted োগ গুক্রা টকন্তু টপ্রন্ট বয ভয় আক্ফ না। বটা কাক্জয ুটফধাক্র্ড ফা পফাঝায 
ুটফধাক্র্ড বই োগটা টেক্য় পনয়া মায়। াধায্ে টর্পল্ট অফস্থায় বটা র্াক্কনা। মটে বই োগটা 
টেক্ে চান োক্র টনক্চয ছটফ ২টা রক্ষ করুন। 
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োযয আফায columns পর্ক্ক two টক্রক্ট করুন। 
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োক্র ছটফয ভে বাক্ফ পরখাগুক্রা ক্য় মাক্ফ। প্রর্ক্ভ বককরাভ ও োযক্য পরখাগুক্রা ২ করাক্ভ। 
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টনক্চয ছটফক্ে পেখাক্না রার যক্ঙয I বয স্থাক্ন কাডয যাখুন। োযয 
Break > continuous। 
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োক্র আফায ২ করাক্ভয টনক্চ বকটট dotted line পেখা মাক্ফ। 
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োযয columns ব পমক্য় one টক্রক্ট করুন। 
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পরখাগুক্রা টনক্চয ভে ুন্দয বাক্ফ াটজক্য় গুটছক্য় আক্ফ। বই ধযক্নয পরখা পটটফর ফযফায কক্য 
easily কযা মায়, মা আভযা যফেডীক্ে পেখফ। hira
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বখন line numbers পর্ক্ক ইচ্ছা কযক্র রাইন নাম্বায টেক্ে াক্যন। 
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ছটফক্ে পেখাক্না স্থাক্ন মান বফ  Print preview mode select করুন। োক্র পেখক্ফন dotted 
line গুক্রা পেখা মাক্চ্ছ না। আয Print preview mode মা পেখা মাক্ফ শুধুভাত্র পগুক্রাই print 
ক্ফ অনয টকছু print ক্ফনা। hira
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বখন আভযা Page Layout Menu বয Page Background নাভক অনটা পেখফ। 
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উক্যয ছটফক্ে পেখুন টেনটা অন আক্ছ Watermark, Page Color ও Page Borders। বয 
ভক্ধয আভযা প্রর্ক্ভ watermark option টা পেখফ। বটায াক্র্ কভক্ফট আভযা ফাই টযটচে। 
পমভন আটন বই ফইটটক্ে বকটট Watermark পেখক্ে াযক্ছন। াধায্ে বটা পকান প্রটেষ্ঠান 
ফা ফযটিয টনজস্বো পফাঝাক্ে ফা পকান ের্য বয কট পযাধ কযক্ে বই অনটট ফযফায কযা মায়। 
পমভন আভযা পেক্খটছ অক্নক পকাটচ  পন্টায ফা টফটবন্ন যাক্যয পনাক্টয টবেক্য বই যাক্যয নাভ 
অর্ফা পকাটচ  পন্টায নাভ র্াক্ক মাক্ে অনয পকউ বটাক্ক টনক্জয নাক্ভ চাটরক্য় টেক্ে না াক্য। 
াধায্ে watermark র Background ব পকান টফক্ল পটক্সট ফা ছটফ জরছা ফা 
transparent বাক্ফ পেয়া। জরছা পেয়ায জনয প্রর্ক্ভ আটন Watermark menu পর্ক্ক 
Custom Watermark click করুন 
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োযয টনক্চয ভে পেখক্ে াক্ফন। বখান পর্ক্ক প্রক্য়াজনীয় অন টক্রক্ট কক্য apply কক্য ok 
করুন। মটে পকান ছটফক্ক watermark টক্ক্ফ ফযফায কযক্ে চান োক্র ২য় অন ফাছাই 
করুন ও Select picture পর্ক্ক ছটফটট পেটখক্য় টেন। আয পকান পরখা ফা text পক watermark 
টক্ক্ফ চাইক্র, Text ঘক্য আনায প্রক্য়াজনীয় পরখা টেন। বখাক্ন আটভ Do not copy টেক্য়টছ 
আটন আনায নাভ টেক্ে াক্যন। Diagonal select কযক্র পরখাটট পকানাকুটন অর্ফা ক্ড ফযাফয 
ক্ফ আয Horizontal select কযক্র নযভাটর আভযা পমবাক্ফ টরটখ পই বাক্ফ ক্ফ টকন্তু বকটু ফে 
পক্ন্ট। hira

ctg
.blog

spot.
com



    

 

Page border পেয়ায জনয বখান পর্ক্ক page border ব টিক করুন। 

 

োযয টনক্চয ছটফটট পেখুন বখাক্ন প্রক্য়াজনীয় ফ অন াক্ফন। 
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পক্জয চাযাক্ border টেক্ে চাইক্র Box select করুন। োযয border টক্ক্ফ রাইন টেক্ে 
চাইক্র style পর্ক্ক select করুন। color ও width প্রক্য়াজক্ন টযফেডন কযক্ে াক্যন। আয মটে 
বকটু অনয ধযক্নয border চান োক্র Art বয টবেয অক্নক ুন্দয ুন্দয ফর্ডায াক্ফন, পমটা 
ছন্দ ক্ফ পটাক্ে টিক কযক্রই ক্ফ। আয র্ান াক্ preview পেখক্ে াক্ফন। ফাক্ ফর্ডায 
না চাইক্র বখান পর্ক্ক উটিক্য় টেক্ে াক্যন, োয জনয ছটফক্ে পেখাক্না স্থাক্ন টিক কক্যন। ফক্ক্ল 
Ok করুন।  
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আজ আভযা পজ পরআউট পভনুয paragraph setion পেখফ, বগুক্রা আক্র খুফই পাজা। ফই 
পেয়া আক্ছ আনাক্ক শুধু কষ্ট কক্য ভান ফটক্য় টেক্ে ক্ফ। টনক্চয ছটফক্ে রক্ষ করুন। আা কটয 
ফুঝক্ে াযক্ফন। 
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 Left Indent বয ভাধযক্ভ আটন ফাভ া পর্ক্ক টনটেডষ্ট টযভান জায়গা ছােক্ে াক্যন। 
 Right Indent দ্বাযা আটন অনুরূক্ র্ান া পর্ক্ক টনটেডষ্ট টযভান জায়গা ছােক্ে াক্যন। 
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 Before spacing দ্বাযা আটন বকটট যাযায উক্য কেটুকু পাকা যাখক্ফন ো টনটেডষ্ট কযক্ে 
াক্যন। 

 After spacing দ্বাযা আটন বকটট যাযায টনক্চ কেটুকু জায়গা পাকা যাখক্ফন ো ফক্র টেক্ে 
াক্যন। 

 
উক্যয ছটফয টেক্ক রক্ষ করুন বটা View পভনু। 
প্রর্ক্ভই আক্ছ Document View অ  বয toolbar গুক্রা দ্বাযা আটন টফটবন্ন view টক্রক্ট 
কযক্ে াক্যন। েন্মক্ধয আনায পম টবউ বার রাক্গ পই টবউ টনক্য় আটন কাজ কযক্ে াক্যন। 
টনক্চয ছটফ পর্ক্ক পম পকান বকটা টক্রক্ট কক্য রক্ষ করুন। 

 

 

 
উক্যয ছটফক্ে রক্ষ করুন টফটবন্ন ধযক্নয অন আক্ছ মা দ্বাযা আটন র্কুক্ভন্ট Ruler, 
Gridline ইেযাটে on off কযক্ে াযক্ফন। বগুক্রা আনাযা টনক্জযাই ফুঝক্ে াযক্ফন।  
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উক্যয ছটফয টেক্ক রক্ষ করুন। বখাক্ন Zoom tools বয াাক্ময আটন ইচ্ছা ভে আনায 
পরখা Text পক ফে অর্ফা পছাট কক্য পেখক্ে াক্যন। বক্ে আনায কাজ কযক্ে ুটফধা ক্ফ। 
ভক্ন যাখক্ফন পরখা zoom কযা আয পন্ট াইজ ফে কযা টকন্তু বক কর্া নয়। কাযন আটন মটে 
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Font size ফে কক্যন োক্র পটট printing বয ভয়ও ফে আক্ফ টকন্তু মটে আটন Zoom 
কক্যন োক্র বটা শুধু কটিউটায টিক্্ ফে পেখাক্ফ টকন্তু টপ্রটন্ট  বয ভয় Font size পছাটই 
র্াকক্ফ। 

 
 
উক্যয ছটফক্ে পেখুন টফটবন্ন ধযক্নয জুভ বয অন আক্ছ পমভন ১০০, ২০০ ইেযাটে আফায 
আটন আনায ইচ্ছা ভে জুভ চাইক্র Percent ঘক্য টনটেডষ্ট বযারু put করুন। টনক্চ ছটফক্ে পেখুন 
১৫০% জুভ কযক্র পকভন পেখায়। 
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আফায পেখুন ২ পজ টক্রক্ট কযক্র আনায পজ েুটা পকভন পেখাক্ফ। 

 
 
বখাক্ন আক্র আনায প্রধান কাজ র টফটবন্ন অন টক্রক্ট কক্য পেখা পকান অনটা টকবাক্ফ 
কাজ কক্য ফা পকানটা টক্রক্ট কযক্র পকভন পেখায়। আটন আনায ুটফধাভে বকটট অন 
টক্রক্ট করুন। 
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অক্নক ভয় পেখা মায় আভাক্েয বকাটধক র্কুক্ভন্ট ফা ২-৩টা word file টনক্য় কাজ কযক্ে য় 
পক্ক্ষক্ত্র বই অনগুক্রা খুফ কাক্জ পেয়। 

 

 
পমভন বখান পর্ক্ক আটন মটে Arrange all select কক্যন আয আনায মটে ২ টা ওয়ার্ড পাইর 
ওক্ন র্াক্ক োক্র টনক্চয ভে কক্য াটজক্য় আক্ফ। 

 

 
আফায অক্নক ভয় পেখা মায় বকই র্কুক্ভন্ট বয টফটবন্ন অ  টনক্য় কাজ কযায েযকায য় পমভন 
য়ে বকই পাইর বয ১ভ পজ ও ৩য় পজ টনক্য় বকই াক্র্ কাজ কযায েযকায য়, পক্ক্ষক্ত্র 
Split অনটা ফযফায কযায ভাধযক্ভ আনায বই কাজটট কযক্ে াক্যন। উক্যয অ ক্ মেটুকু 
ফভয় পেখায েযকায পটুকু ফাে পযক্খ টনক্চয পর্ক্ক split কক্যন োক্র টনক্চয অ ক্ অনয 
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পকান পক্জয অনয পকান অ  আনক্ে াযক্ফন ফা উক্যয অ ক্ও অনয পকান অ  পেখক্ে 
াযক্ফন। 

 

 
আফায view side by side select কযক্র টনক্চয ভে পেখা মাক্ফ। 
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বখন আভযা ms word বয খুফই গুরুত্বূ্ড বকটট পভনু িডক্ক আক্রাচনা কযফ। আভায ভক্ে 
ওয়াক্র্ড Insert বফ  Format পভনু খুফই গুরুত্বূ্ড। কায্ বই েুই পভনুয ভাধযক্ভই ওয়াক্র্ডয 
অটধকা  কাজ কযা মায়। আনাযা মটে ওয়ার্ড পখায ভয় menu গুক্রায নাক্ভয ফা রা অর্ড ভক্ন 
যাক্খন োক্র আনাক্ক আয ভক্ন যাখক্ে ক্ফ না পকান টজটনটা পকান পভনুক্ে আক্ছ। 
Insert বয ফা রা অর্ড আনা, প্রক্ফ কযাক্না, পকান টকছুয টবেক্য স্থান কযা, টন্নক্ফটে কযা, 
প াকান ইেযাটে। 
Format বয ফা রা অর্ড র টফনযা কযা, প্রটরয়াজাে কযা ইেযাটে। 

টট: বখন ভক্ন করুন ওয়াক্র্ড আটন বকটট পাকা পজ পমাগ কযক্ে চাক্চ্ছন োক্র বটা পকান 
পভনুক্ে র্াকা উটচৎ, আনায কর্াটটক্কই ই যাজীক্ে টয্ে করুন – পেখুন উত্তয পক্য় মাক্ফন। 
পমাগ কযা অর্ড Insert আয পাকা পজ অর্ড Blank Page োক্র ুযা কভান্ডটট োোর- Insert > 
Blank Page বখান আটন ওয়ার্ড বয Insert পভনুক্ে মান পেক্খন বযকভ অর্ফা বয কাছাকাটছ 
synonym মুি পকান কভান্ড াক্ফন। 
আফায ভক্ন কক্যন আটন বকটট পটটফর পমাগ কযক্ে চাক্চ্ছন োক্র টক কভান্ড ওয়া উটচৎ ফক্রন 
পো? 
যাাঁ টিক ফক্রক্ছন পমাগ কযা অর্ড Insert বফ  পটটফর ই যাজী Table কাক্জই বটা ক্ফ Insert 
পভনুয টবেক্য Table. ববাক্ফই আটন টফটবন্ন কভান্ড পকান পভনুয টবেক্য আক্ছ ো ফুঝক্ে 
াযক্ফন। 

আুন টকছু Option বয কাজ পেক্খ পনয়া মাক। আনাক্েয পেখায ুটফধাক্র্ড আটভ Insert 
পভনুটাক্ক টনক্চ টনক্চ াটজক্য় টেক্য়টছ। পভনুটায Icon গুক্রা বকনজয পেক্খ পনয়া মাক। োযযই 
আভযা আভাক্েয ভূর কাক্জ টপক্য মাফ। 
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ধরুন আভযা টনক্চয ভে বকটা পজ দেটয কক্যটছ। টকন্তু বই পক্জয আক্গ বকটা পাকা পজ 
দেটয কযায েযকায – োক্র টকবাক্ফ দেটয কযক্ফন, প্রর্ক্ভ Mouse pointer পক্জয বকেভ 
উক্য যাখুন োযয keyboard পর্ক্ক CTRL+Enter press করুন অর্ফা টনক্চয ছটফয টেক্ক রক্ষ 
করুন। 
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টনক্চয ছটফক্ে পেখাক্না স্থাক্ন টিক করুন োক্র নেুন বকটট পজ দেটয ক্য় মাক্ফ। োযয বই 
পক্জয আনায মা খুট োই প্রক্য়াজন ভে টরখক্ে াক্যন। hira
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অক্নক ভয় আভাক্েয টফটবন্ন কাক্জয প্রক্য়াজক্ন কবায পজ দেটয কযায েযকায ক্ে। মটেও 
Blank page পর্ক্কই কবায পজ দেটয ম্ভফ টকন্তু অক্নক্কই আক্ছন মাযা কবায পক্জ টর্জাইন 
চান – আফায টনক্জ য়ে অেটা বারবাক্ফ ওয়ার্ড চারাক্ে জাক্নন না, োক্েয ms word ব আক্গ 
পর্ক্ক অক্নক pre made design আক্ছ মায ভাধযক্ভ আনাযা professional কবায পজ দেটয 
কযক্ে াক্যন। আভযা মটে পকান assignment দেযী কযক্ে মাই েখন আভাক্েয বফ design 
অক্নক কাজ আক্ফ। 
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উক্যয ছটফ ভে কক্য কাডয পক্জয ফায উক্য যাখুন োযয পম টর্জাইন ছন্দ য় পটা 
টক্রক্ট করুন। োক্র টনক্চয ছটফয ভে টক্রক্ট কযা cover টা পেখা মাক্ফ। বখন আনায 
প্রক্য়াজন ভে নাভ, টাইক্টর বগুক্রা change কক্য টনন। 
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পটটফর দেটয কযায জনয টনক্চয ছটফয টেক্ক রক্ষ করুন। আনায প্রক্য়াজনভক্ো Row ও Column 
টক্রক্ট কক্য ok করুন। োক্রই পটটফরটট দেটয ক্য় মাক্ফ। 

 

াধায্ে ফাই normal table দেযী কযক্ে াক্য োই আটভ বকটট complex table দেযী 
কযফ। প্রর্ক্ভই চরুন পেটখ আভযা পম পটটফরটা দেটয কযফ, োয আউটরুক পকভন ক্ফ: 

 

প্রর্ক্ভই Insert > Table পর্ক্ক টনক্চ ছটফক্ে পেখাক্না বাক্ফ ৬ করাভ ও ৫ পযা টক্রক্ট কটয। 
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পটটফর দেটয ক্য় মাক্ফ। ছটফক্ে পেখাক্না (+) স্থাক্ন টিক কটয িূ্ড পটটফর টক্রক্ট ক্য় মাক্ফ। 

 
 
োযয ঐখাক্ন mouse পযক্খ Right click কটয, পম পভনু আক্ফ পখান পর্ক্ক borders and 
shading ব টিক কটয। 
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টনক্চয ভে বকটট উইক্ন্ডা আক্ফ, ছটফক্ে পেখাক্না বযারুগুক্রা ুট কটয পমভন All select করুন, 
color change করুন ও ফর্ডায রাইন width টযফেডন করুন। 
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আয র্ান াক্ পেখুন Preview পেখা মাক্চ্ছ। আটন মটে ফ াক্ ফর্ডায না চান োক্র বখান 
পর্ক্ক টফটবন্ন াক্য ফর্ডায উটিক্য় টেক্ে াক্যন বফ  Preview বয টেক্ক রক্ষ করুন, আক্র বটা 
পকভন ক্রা। ফক্ক্ল Ok করুন, োক্র আনায পটটফরটট বভন ক্ফ পেখক্ে। 

 

 
বখন টনক্চয ছটফক্ে পেখাক্না স্থাক্ন ভাউ কাডয টনক্য় মান বফ  টনক্চয টেক্ক Drag কক্য পটটফরটট 
ফে করুন। 

 
 
োক্র টনক্চয ভে বকটট পটটফর দেটয ক্ফ। 
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প্রর্ভ ছটফক্ে রক্ষ করুন আভাক্েয প্রর্ভ পযা বয র্ানাক্ বকটা পর ও োয টনক্চ ৩ টা পর 
আক্ছ। বটা ফানাক্নায জনয আভযা প্রর্ক্ভই প্রর্ভ পযা বয পক্লয ৩ টা পর টক্রক্ট কযফ, োযয 
right click কক্য Merge cells। 

 

 
 
টনক্চয ছটফয ভে বকটট পটটফর দেটয ক্ফ। 

 
 
ঐ পক্র কাডয পযক্খ right click কটয, পম পভনু আক্ফ split cells পরখায উয টিক কটয। 
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টনক্চয ভে পেখক্ে াক্ফন, আফায আভযা পম পটটফরটা ফানাফ োয ছটফটা পেক্খ আুন। ওখাক্ন 
প্রর্ভ পযা বয পক্ল ২টা পযা ও ৩টা করাভ আক্ছ। োই টনক্চয ভে উইক্ন্ডা আক্র করাভ ঘক্য ৩ 
ও পযা ঘক্য ২ ফান বফ  ওক্ক। 

 
 
টনক্চয ভে বকটট পটটফর াক্ফন। 
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বখক্না আভাক্েয কাটিে পটটফক্রয ভে য়টন, োই ছটফক্ে পেখাক্না ৩টা পর বকক্ত্র টক্রক্ট কক্য 
োয উয right click কক্য, merge cells ব click করুন। 

 
 
োক্র টনক্চয ভে বকটট পটটফর াক্ফন মা আভযা দেযী কযক্ে চাটচ্ছরাভ। hira
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বখন বয টবেক্য টকছু র্াটা ইনুট করুন। প্রর্ভ পযা বয কারায টযফেডন করুন ও পফাল্ড করুন। 
োক্র টনক্চয ভে বকটট পটটফর াক্ফন। 

 
 
পটটফক্র বকটা বুর ক্য় টগক্য়ক্ছ াখা বয জনয যাখা করাভটা ও বকজন টুক্র্ন্ট বয নাভ টেক্ে 
বুর ক্য় টগক্য়ক্ছ। আুন পেক্খ টনই টকবাক্ফ আভযা বটা পমাগ কক্য টেক্ে াক্য। প্রর্ক্ভই নেুন 
টুক্র্ন্ট পমাগ কযায জনয বকেভ পক্ল কাডয টনক্য়, right click করুন ও insert ব মান বফ  
Insert Rows Below select কক্যন, োক্রই পেখক্ফন নেুন পযা add ক্য় টগক্য়ক্ছ। hira

ctg
.blog

spot.
com



    

 

 
 
নেুন row পে টনক্চয ভে টকছু ের্য ূয্ করুন। 
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াখা Add কযায জনয পশ্রনী বয পম পকান cell বয কাডয পযক্খ Right click করুন ও Insert 
পর্ক্ক Insert Columns Right select কক্যন, নেুন column add ক্য় মাক্ফ। 

 
 
োযয উক্যয ছটফক্ে ভাকড কযা অ ক্ ভাউ টনক্য় পগক্র কাডয ঐযকভ টচক্হ্ন টয্ে ক্ফ, 
োযয ভাউ ড্রাগ কক্য column বয width টা পছাট কক্য টেন বফ  পটটফরটা বকটু ফাক্ভ ভুব 
কযান োক্র টনক্চয ভে পেখক্ে ক্ফ। 

 

 
বফায নেুন দেটয ওয়া করাভ উক্যয ২ টা পর ভাজড কটয, বয জনয ২টা টক্রক্ট কক্য, যাইট 
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টিক কক্য Merge cells ব টিক কক্যন। ছটফয ভে। 
 

 

 
টনক্চয ছটফয ভে বকটট পটটফর দেটয ক্ফ। 

 
 
আনাক্েয জনয বকটা ফাটেয কাজ র্াকক্রা পেক্খন পো াক্যন টকনা? টনক্চয ছটফয ভে বকটট 
পটটফর দেটয করুন। 
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আভযা বখন নেুন আক্যকটট table দেটয কযফ। টক দেটয কযক্ফা ো প্রর্ক্ভই বক নজয পেক্খ 
টনই। 

 

 
আা কটয উক্য complex table ব পেখাক্না কাজ মাযা বারবাক্ফ ফুঝক্ে পক্যক্ছন োযা খুফ 
ক্জই উক্যয পটটফরটা কযক্ে াযক্ফন। বটা অফয আভযা বকটু অনয উাক্য়ও ফানাক্ে াটয। 
পক্ক্ষক্ত্র আভাক্েয গুক্ন টনক্ে ক্ফ পম আভাক্েয প্রক্য়াজনীয় পটটফক্র ফা আভযা পম পটটফরটট ফানাফ 
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পটাক্ে কয়টা Row আক্ছ। পমভন উক্যয ছটফক্ে পেখুন Column বয  খযা অভান টকন্তু Row 
বয  খযা ভান, োই প্রর্ক্ভ আভযা Insert > Table পর্ক্ক বকটা পটটফর কভান্ড টেফ মায Row 
5টা বফ  Column 1টা। যফেডীক্ে আভযা করাক্ভয  খযা টিক কক্য টনফ। োক্র আভযা বভন 
বকটা পটটফর াফ মায row- ৫ টা ও column- ১ টা 

 
 
প্রর্ভ ১ভ Row পে ভাউ ক্য়ন্টায পযক্খ Right Click কক্য Split cells ব টিক কটয। 
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প্রর্ভ ছটফ পর্ক্ক পেক্খ টনই First row পে কয়টা করাভ আক্ছ, পম কয়টা প কয়টা বই ঘক্য 
ফটক্য় পেফ। োই আভযা বখাক্ন value টক্ক্ফ 3 টেক্য়টছ। 

 

োক্র আভযা টনক্চয ভে বকটট পটটফর াফ। 

 

 
আফায ২য় পযাক্ে বকইবাক্ফ Right Click কক্য Split cells ব টিক কটয। 
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বখন পম উইক্ন্ডাটা আক্ফ বটায Column বয বযারু টক্ক্ফ ৪ put কটয বফ  ok কটয। 

 

 
োক্র টনক্চয ভে পেখক্ে বকটা পটটফর াফ। 
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আভায টফশ্বা আনাযা মটে অনুরূবাক্ফ াভক্নয টেক্ক বটগক্য় মান োক্র আনাযা টনক্চয ভে 
বকটট পটটফর খুফ ক্জই ফানাক্ে াযক্ফন। 

 

প্রর্ক্ভই 3 column ও 5 row টফটষ্ট বকটট পটটফক্রয কভান্ড টেন। 
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োযয কাক্জয ুটফধাক্র্ড আক্গ পেখাক্না টনয়ভানুমায়ী পটটফক্রয ফর্ডায বকটু Thick/পভাটা কক্য 
টেন, োক্র টনক্চয ভে বকটট পটটফর াক্ফন। 

 
 
পটটফরটট টক্রক্ক্টর্ র্াকা অফস্থায় উক্যয পভনু ফায পর্ক্ক Design select করুন। 
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বফায টর্জাইন টুর পর্ক্ক বকেভ পক্লয Eraser টুরটা টক্রক্ট কক্য টেন। 

 
 
োযয টনক্চয ছটফয রার টচটহ্নে অ ক্ ভাউ ক্য়ন্টায টনক্য় মান বফ  টিক করুন। 
 

 
োক্র টনক্চয ভে বকটট পটটফর াক্ফন। 
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আফায Design toolbar পর্ক্ক Draw Table select করুন। 

 
 
টনক্চয ছটফয রার টচটহ্নে স্থাক্ন ভাউ ক্য়ন্টায ড্রাগ করুন, োক্র পটটফক্র নেুন নেুন cell দেটয 
ক্ফ। 
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টনক্চয ভে বকটট পটটফর াক্ফন 

 
 
বখন আফায টর্জাইন পভনুফায পর্ক্ক ভাকড কযা অ ক্ টিক করুন বফ  6pt select করুন। 
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টনক্চয ছটফক্ে পেখুন পম পম স্থাক্ন টিক কযা ক্য়ক্ছ পই পই স্থাক্ন োগটা অনয োগগুক্রায পচক্য় 
পভাটা ক্য় টগক্য়ক্ছ। 

 
 
আফায design পভনু পর্ক্ক Pen color tools ব টিক কক্য Light Blue কারাযটট টক্রক্ট কটয। hira

ctg
.blog

spot.
com



    

 
 
োযয ছটফক্ে পেখাক্না স্থাক্ন টিক কযক্র ঐ স্থানগুক্রাও Light Blue color ক্য় মাক্ফ। 

 
 
বফায Design menu বয Border অ  পর্ক্ক টনক্চয ভে বকটট Line style select কটয বফ  
ো পটটফক্রয চাযাক্ Outside border টক্ক্ফ ফযফায কটয। 
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োক্র টনক্চয ছটফয ভে চাযাক্ ুন্দয বকটা ফর্ডায পক্য় মাফ। 
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আফায বকটা পটটফর দেটয কটয ৮পযা ও ১০করাভ টফটষ্ট 

 
 
Design menu বয Table styles পর্ক্ক পম পকান বকটা টাইর ছন্দভে টক্রক্ট কটয। োক্রই 
আভযা টনক্চয ভে বকটট পটটফর াফ। 
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আা কটয আনাক্েয পটটফর টনক্য় আয পকান কাজই ভযা ক্ফ না- মটে বকটু ফুটদ্ধ খাটাক্ে 
াক্যন। কায্ পভাটাভুটট বই কাজগুক্রা জানক্রই পম পকান ধযক্নয পটটফর ফানাক্না ম্ভফ। 

আা কটয আনাক্েয ভক্ন আক্ছ, আনাক্েয ফক্রটছরাভ পম করাক্ভয কাজটা Table টেক্য়ও কযা 
মায়, পমটা আটভ আনাক্েয ক্য পেখাফ। আনাযা মটে পটটফর ফানাক্না বারবাক্ফ টক্খ র্াক্কন 
োক্র ঐ কাজটা পটটফর টেক্য় করুন। প্রর্ক্ভ পটটফর ফানান যফেডীক্ে পটটফক্রয border 0 কক্য 
োক্রই ক্য় মাক্ফ। 
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উক্যয ছটফটা পেক্খন আয আভাক্েয ূক্ফডয কযা কাজটট বকই যকভ। উক্যয উোযন টকন্তু 
পটটফর টেক্য় দেটয, আনায বটা Print Preview অফস্থায় পেখক্ছন। আয স্বাবাটফকবাক্ফ বটা 
বভন পেখাক্ফ। 
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োক্র পেটয না কক্য দেটয কক্য পপরুন। 

আয মাযা াযক্ফন না োযা াভক্ন পমক্কান বক জায়গায় বয ভাধান পক্য় মাক্ফন, টকন্তু ফাই 
বকফায ক্রও পচষ্টা কযক্ফন।   

 

বখন আনাক্েয াক্র্ Insert menu আযও ২টট গুরুত্বূ্ড অন টকবাক্ফ কাজ কক্য, ো 
পেখাফ। প্রর্ক্ভই Insert menu বয Picture ব টিক করুন। 
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োক্র টনক্চয ভে উইক্ন্ডা পেখক্ে াক্ফন, বখান পর্ক্ক ছক্ন্দয ছটফ টক্রক্ট কক্য Insert ব টিক 
করুন। 
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োক্রই পেখক্ফন টক্রক্ট কযা ছটফটট Word বয টবেক্য চক্র আক্ছ। 
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টকন্তু বখাক্ন বকটা ভযা আক্ছ, আয ো র ছটফটা আটন ইচ্ছাভে যাক্ে াযক্ফন। কায্ 
বখন Text wrap কযা আক্ছ। োই ছটফটা ইচ্ছাভক্ো যাক্ে ক্র আনাক্ক format tab পর্ক্ক 
Text Wrap option পর্ক্ক In front of text অনটা টক্রক্ট কযক্র ছটফটা খুফ বারবাক্ফ ভুব 
কযাক্ে াযক্ফন। 
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আয পেখুন ছটফক্ে পম অনগুক্রা আক্ছ পই অনগুক্রায কাজ পফাঝায জনয আনাযা 
ব্দগুক্রায ফা রা অর্ড পেক্খ টনন। আা কটয অনগুক্রা বক্ক বক্ক টক্রক্ট কযক্রই আনাযা 
বয কাজ ফুঝক্ে াযক্ফন। 
টনক্চয ছটফক্ে রক্ষ করুন 
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বখাক্ন অক্নক অন আক্ছ মায ভাধযক্ভ আনাযা টফটবন্ন কাজ কযক্ে াযক্ফন। টনক্চ টকছু ফ্ডনা 
টেরাভ ফাটকটুকু আা কটয আনাযা কক্য টনক্ে াযক্ফন। 
 
Adjust- বখান পর্ক্ক আটন আনায ছটফয colour, brightness, size ইেযাটে টযফেডন কযক্ে 
াযক্ফন। 
shadow effect- বটা টেক্য় ছটফক্ে ছায়া টেক্ে াযক্ফন। 
picture border- বটা টেক্য় ছটফয চাযাক্ ফর্ডায পেয়া মায়। 
position- ছটফ টফটবন্ন জায়গায় যাখক্ে াযক্ফন। 
bring to front- ছটফ ফায উক্য আনায জনয পমভন েুটা ছটফয টবেক্য পকানটা উক্য র্াকক্ফ। 
send to back- পকান ছটফক্ক ফায টনক্চ যাখায জনয 
text wrapping- আক্গই পেক্খক্ছন 
Align- বটাও আনাযা জাক্নন 
Rotate- ছটফ পঘাযাক্নায জনয ফযফায কযা য় 
crop- ছটফ ফাইক্য পর্ক্ক টকছু অ  কাটায জনয 
বফ Effect পেয়ায জনয ছটফ টক্রক্ট কক্য পম পকান option ব টিক করুন বফ  টযফেডন রক্ষ 
করুন। পমভন আটভ Rotate টা পটট কক্য পেখটছ। 
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প্রর্ক্ভ clip art click করুন 
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োযয র্ান াক্ নেুন বকটট উইক্ন্ডা পেখক্ে াক্ফন। clip organize clip ব টিক করুন 
(অক্নক্কয ব অনটট organize clip option টট নাও র্াকক্ে াক্য, কাযন আটন office 
install কযায clip art install কক্যনটন োই) 

 

 

টনক্চয ভে উইক্ন্ডা আক্ফ। পম পকান folder select করুন টনক্চয ভে পেখক্ে াক্ফন। 
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ছটফক্ে পেখাক্না স্থাক্ন টিক কক্য Copy করুন। 
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োযয বটট close কক্য টেন ও word document ব right click কক্য paste ব টিক করুন। 
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োক্রই clip art টট র্কুক্ভন্ট ব চক্র আক্ফ। 

 

আজ আভযা Insert Menu বয অন্তডগে Header & Footer পভনুয কাজ পেখফ। বটা খুফই 
গুরুত্বূ্ড কায্ াধায্ে ভাটজডন বয টবেক্য পকান টকছু পরখায জনয বটা ফযফহৃে য়। ভাটজডন বয 
টবেয াধায্বাক্ফ পরখা মায় না। অফয Text box ফযফায কক্য আটন ভাটজডন বয টবেক্য 
টরখক্ে াক্যন। টকন্তু header & footer অন ফযফায কযক্র page number গুক্রা প্রটে 
পক্জ Automatic বাক্ফ change ক্য় মায়, প্রটে পক্জয টাইক্টর automatic বাক্ফ টনক্য় পনয় – 
ফায ফায পরখা রাক্গ না। বইফ কাযক্্ header & footer অন ফযফায কযা অক্নক 
রাবজনক। 
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টনক্চয ছটফক্ে পেখুন header & footer বয অফস্থান ভাকড কক্য পেখাক্না ক্য়ক্ছ। 
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Document পর্ায পমাগ কযায জনয Insert > Header ব টিক করুন। োযয টনক্চয ভে পভনু 
পেখা মাক্ফ। বখান পর্ক্ক ছন্দভে টক্রক্ট করুন। বখাক্ন Preview পেয়া আক্ছ আা কটয 
আনাযা বয preview পেখক্রই ফুঝক্ে াযক্ফন, পকান header টা আনায প্রক্য়াজনীয়। 
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আটভ পমভন পেখুন colorful বকটা header টক্রক্ট কক্যটছ, পমটায় োটযখ ও document title 
পেয়ায অন আক্ছ। 
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বকইবাক্ফ Footer menu পে পমক্য় পম পকান footer select করুন। 
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পেখুন আটভ Blank three column পুটায টক্রক্ট কক্যটছ। বখাক্ন ইচ্ছা কযক্র আটভ টফটবন্ন 
ধযক্নয ের্য টেক্ে াটয। hira

ctg
.blog

spot.
com



    

 
 
Page number অন ব মান বখান পর্ক্কও আটন যাটয page no. টেক্ে াযক্ফন। ছটফক্ে 
পেখুন আটভ Page margins > Accent Bar, Right টক্রক্ট কক্যটছ মায পক্র ছটফয ভে র্ান 
াক্ Page no. পক্য়টছ। 
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আটন মটে  খযা টেক্য় page no. না চান, আটন মটে চান পযাভান যক্প আনায পজ ন  ক্ফ 
ফা পজ ন  ৫ পর্ক্ক শুরু ক্ফ। পক্ক্ষক্ত্র আটন বই অক্ন পমক্ে াক্যন। 
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ছটফক্ে পেখাক্না স্থাক্ন টিক কক্য আটন আনায ছন্দভে Number format টক্রক্ট করুন। 
োযয টনক্চ পেখুন পমক্কান নাম্বায পর্ক্ক ফা ূক্ফডয পজ ন  পর্ক্ক পজ নাম্বায শুরু কযায 
option আক্ছ। 
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বখন আভযা Insert পভনু বয Text toolbar বয টকছু অ  পেখক্ফা। 

 
 
প্রর্ক্ভই আভযা Text box ফানাক্না টখফ বয ুটফধা র বটট আটন পম পকান স্থাক্ন যাখক্ে 
াযক্ফন। অক্নক ভয় অক্নক টকছু আটন আনায কাটিে স্থাক্ন টনক্ে াযক্ফন না পক্ক্ষক্ত্র 
Text box ফযফায কযক্ে াক্যন। 
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পটক্সট ফক্স দেটয ওয়ায য টনক্চয ভে পেখাক্ফ। 

 
 
ফর্ডায ছন্দ না ক্র টনক্চয ছটফক্ে পেখাক্না স্থাক্ন টিক কক্য ফর্ডাযটা ভুক্ছ টেক্ে াক্যন। 
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আয বই ফর্ডাযটা টকন্তু Print কযায য পেখা মায়না। 

 

 
 
োই পটক্সট ফক্স ফযফায কক্য অক্নক টকছু কযা মায়। 
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Quick Parts menu বয টেক্ক রক্ষ করুন, বখাক্ন অক্নক টকছু আক্ছ, মা দ্বাযা আটন অক্নক 
টকছু খুফ দ্রুে কযক্ে াযক্ফন। 

 
 
আা কটয বখানকায অনগুক্রা আনাযা টিক কযক্রই ফুঝক্ে াযক্ফন, পকানটা দ্বাযা টক য়। 
আটভ পমভন পেক্খন Publish date ব টিক কক্যটছ। টনক্চয ভে পেখক্ে াক্ফন। hira

ctg
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বখান পর্ক্ক প্রক্য়াজন অনুমায়ী পর্ট টক্রক্ট করুন পটাই র্কুক্ভন্টব show কযক্ফ। 

আনাক্েয টনশ্চয়ই ভক্ন আক্ছ, আটভ আনাক্েয বকটা task টেক্য়টছরাভ(column work done 
by table), পটা মাক্েয কযক্ে ভযা ক্য়ক্ছ োক্েয জনয আটভ ঐ কাজটট কক্য টেটচ্ছ, আা কটয 
যফেডীক্ে আনাযা টনক্জযাই কযক্ে াযক্ফন। প্রর্ক্ভই টনক্চয ছটফয ভে Insert > Table পর্ক্ক 
১করাভ ও ৩পযা টফটষ্ট বকটট পটটফর দেটয করুন। 
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োযয ২য় পযা টক্রক্ট কক্য, Right Click করুন ও Split Cells ব টিক করুন। 
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বখন টনক্চয ছটফয ভে Number of columns বয ঘক্য value টক্ক্ফ 2 টেন। ওক্ক করুন। 

 

 
 
বফায আটন বই পটটফক্রয টবেয আনায প্রক্য়াজনীয় Text গুক্রা টরখুন। 
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ছটফক্ে পেখুন বখক্না টকন্তু চাযাক্য black border পেখা মাক্চ্ছ। োই আভাক্েয বই ফর্ডাযটা 
None কযক্ে ক্ফ। বই ফর্ডায remove কযায জনয টনক্চয ছটফয ভে িূ্ড পটটফরটা টক্রক্ট কক্য 
right click কক্য Border and shading ব টিক করুন। 

 
 
বফায আনাক্েয াভক্ন নেুন বকটা উইক্ন্ডা আক্ফ বখান পর্ক্ক None select করুন। 
Preview box ব পেখুন চাযাক্য ফর্ডায পনই। ওক্ক করুন। hira

ctg
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বখন File > Print > Print Preview পে মান োক্র পেখক্ফন টনক্চয ভে পেখা মাক্ফ। 
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আয বটা পেক্খ পকউ ফরক্ে াযক্ফনা পম আটন বই কাজটা পটটফর ফযফায কক্য কক্যক্ছন নাটক 
করাভ ফযফায কক্য। বই বকই ধযক্নয কাজ টকন্তু আনাযা Text box টেক্য়ও দেটয কযক্ে 
াযক্ফন। টক- টনক্জয ফুটদ্ধ টেক্য় দেটয কযক্ে াযক্ফন পো? আা কটয অফযই াযক্ফন। কায্ 
আক্গই ফক্রটছ পম Text box বভন বকটা element মা আটন Microsoft Word Document 
বয পম পকান জায়গায় ফযফায কযক্ে াযক্ফন। আয বটা ফযফায কযায য ূক্ফড পেখাক্না 
টনয়ভানুমায়ী Border None কক্য টেক্ফন োক্রই ক্য় মাক্ফ। 
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বখন আভযা ওয়ার্ড বয WordArt option টা পেখক্ফা। বটা দ্বাযা অক্নক ুন্দয কক্য পরখা মায়। 
বখাক্ন PreMade টকছু পটক্সট টাইর আক্ছ মা আনাযা শুধুভাত্র টক্রক্ট কক্য ফযফায কযক্ে 
াযক্ফন। বটা দ্বাযা পরখায় টফটবন্ন ইক্পক্ট পেয়া মায়। আটভ আনাক্েয বখাক্ন টকবাক্ফ পরখা শুরু 
কযক্ে য় বটা পেখাফ আয ফাটক অনগুক্রা টনক্জযা পচষ্টা কক্য টক্খ টনক্ে ক্ফ। 
প্রর্ক্ভই Insert > Wordart ব মান ছন্দভে বকটট টর্জাইন বয উয টিক করুন। 

 

 
আটন মা টরখক্ে চান, পটা ক্যয উইক্ন্ডাক্ে টরখুন 
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ওক্ক করুন টনক্চয ভে পটক্সট াক্ফন। 

 

োযয টনক্চয ছটফক্ে পেখাক্না স্থাক্ন Mouse টনন ও ছটফটট ফে করুন। 
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োক্র টনক্চয ভে াক্ফন। 

 
 
বফায উক্যয ছটফক্ে পেখাক্না স্থাক্ন, Red point বয ভাঝখাক্ন পম ক্য়ন্ট পেখা মাক্চ্ছ বয উয 
আনায Mouse Pointer টট টনন ও টনক্চয টেক্ক Drag করুন। বযকভ বকটট ছটফ পেখক্ে 
াক্ফন। 
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বখন আটন মটে বই পরখায য  টযফেডন কযক্ে চান োক্র পরখায উয প্রর্ক্ভ Double Click 
করুন। পেখক্ফন Format পভনু টক্রক্ট ক্য় টগক্য়ক্ছ। বফায পেখুন টনক্চ ছটফক্ে প্রক্য়াজনীয় অন 
গুক্রা ভাকড কক্য পেখাক্না ক্য়ক্ছ। 
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hira
ctg

.blog
spot.

com



    

 
 
Shape Fill – বটা দ্বাযা আনাযা পরখায য  টযফেডন কযক্ে াযক্ফন। বছাোও পেখুন আক্যা 
অক্নক অন আক্ছ পমভন: Gradient, pattern, picture etc. 
Shape Outline – বটা দ্বাযা আনাযা পরখায চাযাক্ পম ফর্ডায ফা Outline র্াক্ক পটা 
টযফেডন কযক্ে াযক্ফন। 
Change Shape – বটায ভাধযক্ভ পরখায টফটবন্ন পক্ টযনে কযক্ে াযক্ফন পমভন ফৃত্ত, 
অটধফৃত্ত, উফৃত্ত, টযাটভর্, ইেযাটে। 
Shadow Effects – বটায ভাধযক্ভ পরখায় টফটবন্ন ধযক্নয পর্ ফা ছায়া ইক্পক্ট পেয়া মায়। 
3-D Effects – বই ইক্পক্টটা টেক্য় আটন খুফ ক্জই আনায Text পক 3d ফাটনক্য় পপরক্ে 
াক্যন। 
আনাযা মটে বই অন ফা ইক্পক্ট গুক্রায টিকবাক্ফ combination কযক্ে াক্যন, োক্র 
আনাক্েয আয পছাটখাট ইক্পক্ট বয জনয Photoshop ফা Illustrator ফযফায কযা রাগক্ফ না, 
আনাযা ওয়ার্ড ফযফায কক্যই আনাক্েয পছাটখাট ইক্পক্ট বয কাজগুক্রা পক্য পপরক্ে াযক্ফন। 
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বখন আটভ আনাক্েয ms word ফযফায কক্য টকবাক্ফ Logo create কযা মায় ো পেখাফ। 
আভযা আক্গ পমফ কাজ পেক্খটছ পগুক্রা টেক্য়ই আভযা বই পরাক্গাটা ফানাক্ে াযক্ফ। আুন শুরু 
কটয: 
প্রর্ক্ভই Insert > Shapes পর্ক্ক পেখাক্না shape টা টক্রক্ট কটয। 
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োযয ভাউ ক্য়ন্টায ড্রাগ কক্য shapeটট দেটয কটয। 
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ছটফক্ে ভাকড কযা স্থানগুক্রাক্ে ভাউ ক্য়ন্টায টনন বফ  ভাউ পচক্ ধক্য টফটবন্ন টেক্ক ড্রাগ করুন 
বফ  টযফেডন রক্ষ করুন। 
ছটফক্ে আটভ বকটট কারায কক্যটছ Shape fill দ্বাযা hira

ctg
.blog
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োযয রুে ক্য়ন্টায ধক্য ভাউ ক্য়ন্টায টবেযকায টেক্ক ড্রাগ কযক্র বভন ক্ফ 
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ফুজ ক্য়ন্টায টেক্য় পম পকান shape rotate কযা মায় 
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বখন আভযা পরাক্গা ফানাক্নায আর কাজ শুরু কযফ। প্রর্ক্ভই টনক্চ পেখাক্না পটা টক্রক্ট 
করুন। 
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Shapes fill টেক্য় কারায করুন 
 

 
োযয টনক্চয পটা create করুন 
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ভাকড কযা অ গুক্রাক্ে ভাউ ক্য়ন্টায টনন বফ  বটট ফে করুন। hira
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োক্র বটট টনক্চয ছটফ ভে পেখক্ে ক্ফ 
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বটাও বকটু কারায কক্য টনই,  
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বযয আটন shape টটয উয Mouse বয right button click করুন োযয add text 
option select করুন, টনক্চয ছটফ পেখুন  hira

ctg
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োযয Insert > word art টক্রক্ট করুন 
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টনক্চয ভে টরখুন (আটন ইচ্ছা কযক্র font change কক্য টনক্ে াক্যন পমভন আটভ kalpurush 
font টট select কক্যটছ)  

 
 
োযয আটন shape fill পর্ক্ক রার কারায select করুন 
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আফায আক্গয ভে add text টেক্য় Word art select করুন 
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টনক্চয Text টুকু টরখুন 
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টনক্চয ছটফয ভে পগার প টেন।  
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োযয আফায shapes পর্ক্ক বই পটট টক্রক্ট করুন। 
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Shape টটক্ক আভযা আভাক্েয পরাক্গায ভাঝখাক্ন ফটক্য় shape fill select কটয  
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ফক্ক্ল আভাক্েয দেটয কযা পরাক্গাটট বভন পেখক্ে ক্ফ। 
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আা কটয আনাক্েয বার পরক্গক্ছ। ববাক্ফ ms word ফযফায কক্য আক্যা অক্নক ুন্দয কাজ 
কযা মায়। আনাযাও বকটু পচষ্টা কযক্রই াযক্ফন।  

বখন আটভ আনাক্েয ms word বয খুফই গুরুত্বূ্ড বকটট কাজ পেখাক্ফা। আটভ বখন 
আনাক্েয পম টুরটটয কাজ পেখাফ বয নাভ র Equation বটা Insert menu বয টবেক্য 
াক্ফন। Equation অর্ড ফুঝক্েই াযক্ছন, যা বটা টেক্য় টফটবন্ন ধযক্নয Math টরখক্ে াযক্ফন। 
অক্নক্কই math word ব টাই কযায প্রক্য়াজন ক্র drawing tool ফযফায কক্য ফা অনয 
পটওয়যায ফযফায কক্য। টকন্তু আনাযা খুফ ক্জই equation option ফযফায কক্য জটটর 
জটটর অ ক ও কক্িাজ কযক্ে াযক্ফন পমভন- Matrices, Calculus, Limit, Function, 
Fourier series, Normal algebra equation and so on. 
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Equation টেক্য় কাজ কযা অক্নক জ টকন্তু োয আক্গ আনাক্ক বকটা কাজ কযক্ে ক্ফ আয 
পটা র পকান অন বয টবেয পকান অ ক বয symbol গুক্রা আক্ছ ো পেক্খ টনক্ে ক্ফ। 
প্রর্ক্ভ অ ক্কয টেক্ক োকান বফ  টিক পই যকভ পেখক্ে symbol টা equation menu পর্ক্ক 
select করুন োযয just click and type. 

আুন আটভ আনাক্েয ুটফধায জনয টকছু পভনুয screenshot টেটচ্ছ আয ফাটক পভনু গুক্রা 
আনাক্েয টনজ োটয়ক্ত্ব পেক্খ টনক্ে ক্ফ। 

 
 
টনক্চয ছটফক্ে পেখুন অক্নক ধযক্নয Template দেটয কযা আক্ছ। আনায equation বয াক্র্ 
বগুক্রা টভরক্র বগুক্রাও টিক কক্য ফযফায কযক্ে াক্যন 
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পেখুন আটভ বকটট টক্রক্ট কক্যটছ। আনাযা বটটক্ক ইচ্ছা কযক্র modify কযক্ে াক্যন। 
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পেখুন equation tools বয design menu বয টবেয টফটবন্ন ধযক্নয প্রেীক পেয়া আক্ছ। 
বগুক্রাও ভাক্ঝ ভাক্ঝ ফযফায কযা রাগক্ে াক্য। 

 
 
টনক্চয ছটফক্ে পেখুন বখাক্ন আক্যা অক্নক ধযক্নয symbol পেয়া আক্ছ, আনাযা শুধুভাত্র বগুক্রায 
উয click কক্য ফযফায কযক্ে াযক্ফন 

 
 
Operator’s বয উয টিক কযক্র বভন ছটফ আক্ফ। 
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োযয আফায পেখুন Fraction ব টিক কযক্র আভযা টকবাক্ফ ফা কে বাক্ফ বগ্া  পরখা মায় ো 
show কযক্ছ। hira

ctg
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ববাক্ফই ফাটক অনগুক্রা টিক কক্য পেখুন। 

বখন টনক্চয ছটফটা পেখুন আভযা বভন বকটা ভযাটিক্স দেটয কযক্ফা। 
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বটা দেটয কযায জনয টনক্চয ধাগুক্রা অনুয্ করুন 
উক্যয ছটফক্ে পেখুন ২ াক্ ২ টা 3rd bracket আক্ছ োই প্রর্ক্ভই আভযা টনক্চয ছটফয ভে 
কক্য 3rd Bracket বয উয টিক কযক্ফা। 
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টনক্চয ছটফয ভে ক্ফ 
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োযয Matrix menu পর্ক্ক ৩ x ৩ empty matrix বয উয টিক করুন 

 
 
োযয mouse টেক্য় টিক করুন ও keyboard পর্ক্ক প্রক্য়াজনীয়  খযা টরখুন োক্রই ক্য় 
মাক্ফ। 
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বফায আভযা টনক্চয ছটফয ভে function টট দেটয কযক্ফা। 

 
 
বজনয প্রর্ক্ভই আভযা Limit and Log পর্ক্ক ছটফক্ে পেখাক্না ৩ নম্বয অনটা টক্রক্ট কটয। 
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োযয lim বয টনক্চয ঘক্য টিক কটয keyboard পর্ক্ক X টরটখ, োযয symbol পর্ক্ক 
arrow select কটয বফ  োযয 4 type কটয োক্র টনক্চয ভে ক্ফ। 
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বখন পেখুন আভাক্েয অ ক্ক রফ ও য ফা Numerator ও denominator আক্ছ োই আভযা 
ছটফয ভে বই টচহ্নটা টক্রক্ট কযক্ফা hira

ctg
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োযয উক্যয অ ক্ 3- টরটখ বফ  পভনু পর্ক্ক Root sign টা add কটয। 
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োযয x-5 টরটখ 
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োযয ক্যয অ ক্ টিক কক্য x- টরটখ বফ  পভনু পর্ক্ক superscript option টা টক্রক্ট কটয। 
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োযয টিক কক্য 3 বফ  ২ টরটখ। োক্রই আভযা আভাক্েয প্রক্য়াজনীয় Equation টা পক্য় 
মাফ। 

 
 

 

 

 
আভযা উক্যয বই ছটফটটয ভে type কযক্ফা। 
বজনয প্রর্ক্ভই ms word বয insert পভনুয equation পর্ক্ক ছটফয ভে Insert new 
equation ব টিক করুন। 
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োযয বভন আক্ফ 
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অ ক বয টেক্ক রক্ষ করুন বফ  ছটফয ভে Limit and Log menu পর্ক্ক বকই যকভ পেখক্ে 
Log select করুন 

 
 
োযয টনক্চয অ ক্ টিক করুন ও অঙ্ক পেক্খ টাই করুন 

 
 
পরখা ক্য় পগক্র ভান টচহ্ন টেক্য় আফায Log টনক্য় আুন বফ  অ ক পেক্খ টাই করুন 
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োক্রই টনক্চয ভে অ কটট টাই কযা ক্য় মাক্ফ। 

 

বফায আভযা টনক্চয ভে বকটট অ ক কক্িাজ কযক্ফা hira
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বজনয প্রর্ক্ভই অঙ্কটায টেক্ক বারভে রক্ষ করুন োযয large operator পর্ক্ক বকই যকভ 
পেখক্ে বকটট summation টচহ্ন টনন 
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োযয টিক ও টাই করুন বফ  symbol পর্ক্ক Infinity াইন ফান। hira
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োযয পমক্েু বগ্া  আক্ছ, োই বকই যকভ পেখক্ে fraction sign টনন 
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টাই করুন ও টনক্চ Script পর্ক্ক superscript select করুন 
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টাই করুন ও Fraction টনন 
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ববাক্ফই complete equationটট টরক্খ পপরুন। 
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বখন আটভ আনাক্েয াক্র্ পম টফলয়টা পয়ায কযক্ফা োয নাভ র Chart. আা কটয আনাযা 
ফাই চাক্টডয ফযাক্য কভ পফট জাক্নন। চাটড টেক্য় াধাযনে পম পকান ধযক্নয র্াটা খুফই জ 
বাক্ফ উস্থান কযা মায়, পক্র পম পকউ চাটড পেক্খই পরাপর ক্জ ফুঝক্ে াক্য। কাযন 
াধাযনে আভযা পটটফক্রয ভাধযক্ভ আভাক্েয টফটবন্ন ধযক্নয র্াটা উস্থান কটয, টকন্তু ো চাক্টডয 
াাক্ময উস্থান কযক্র বকইাক্র্ জক্ফাধয ও েৃটষ্টনন্দন য়। চরুন আভযা টকবাক্ফ চাটড দেটয 
কযফ ো ধাক্ ধাক্ পেক্খ টনই। আভযা টনক্চয পটটফরটায টেক্ক রক্ষ কটয পমখাক্ন ফরা আক্ছ 

 

প্রটে ১০০ জন ভানুল বয টবেয ৪৫ জন ুরুল ও ৫৫ জন ভটরা আক্ছ, বটাক্ক মটে আভযা pie 
চাক্টডয াাময represent কটয োক্র বভন পেখাক্ফ: 
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বখন বযকভ বকটট চাটড দেটযয জনয প্রর্ক্ভ Insert menu পর্ক্ক chart option ব টিক করুন। 
টনক্চয ভে উইক্ন্ডা আক্ফ বখান পর্ক্ক পম পকান বকটা Pie chart টক্রক্ট করুন বফ  ওক্ক 
করুন। 
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োযয টনক্চয ভে পেখক্ফন excel ও open ক্ফ। আভযা পমক্েু পম পটটফরটা দেটয কযক্ে চাটচ্ছ, 
পটায ভে কক্য excel ব বকই যকভবাক্ফ টরটখ। hira
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োযয টনক্চয ছটফক্ে পেখাক্না স্থাক্ন টিক ও ড্রাগ কক্য আভাক্েয প্রক্য়াজনীয় র্াটা টক্রক্ট কটয 
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ফক্ক্ল পটটফরটট বভন পেখক্ে ক্ফ। 
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ইচ্ছা কযক্র বখন excel close কক্য টেক্ে াক্যন। 
োযয chart style change কযক্ে চাইক্র 

 
 
ছটফক্ে পেখাক্না পভনুক্ে টিক কযক্র টনক্চয ভে অক্নক চাটড পেখক্ে াক্ফন, বখান পর্ক্ক ছন্দ ভে 
বকটা টক্রক্ট করুন 
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োযয চাক্টডয layout change কযক্ে চাইক্র টনক্চয পভনুক্ে মান, ভাকড কযা অ ক্ টিক করুন। 

 
পেখুন বকেভ প্রর্ভটা টক্রক্ট কক্য টেক্র, চাটড বয ইনপযক্ভনগুক্রা অক্নক ুন্দয বাক্ফ show 
কযক্ছ। 
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মটে আনায pie chart ছন্দ না য় োক্র টনক্চয ছটফয ভে change chart types ব টিক 
করুন বভন উইক্ন্ডা আক্ফ ছন্দভে বকটা chart টক্রক্ট করুন। 

 
 
োযয ok কযক্র পেখক্ফন pie chart টযফেডন ক্য় column chart ব টযফেডন ক্য় টগক্য়ক্ছ। 
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বখন আভযা chart টনক্য় আযও কাজ কযফ। আবার Insert menu পর্ক্ক chart বয উয টিক 
করুন। টনক্চয ভে পেখক্ে াক্ফন। 
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োযয ওক্ক কযক্রই টনক্চয ভে word ও excel বকই াক্র্ পেখক্ে াক্ফন। আভযা বখান 
পর্ক্ক Data গুক্রা change কক্য টেক্ফা। 

 
টনক্চয ভে Data পেফ। বখাক্ন ধক্য টনন SSC ও HSC বয ২০১০, ২০১১ ও ২০১২ াক্রয াক্য 
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ায পেয়া আক্ছ মা আভযা Chart আকাক্য পেখফ 

 
 

র্াটা entry ক্য় পগক্র excel close কটয। তাহলে microsoft word ব বভন পেখা মাক্ফ। 

 
উক্যয ছটফয টেক্ক রক্ষ করুন। ব ছটফটট পেখক্রই আটন র্াটা গুক্রা টফক্েল্ না কক্যই যাটয 
ফক্র টেক্ে াযক্ফন পকান ফছয SSC ফা HSC বয াক্য ায বাক্রা টছর। চাটড বইটা ফে বকটা 
ুটফধা ফ টকছু খুফ ক্জই পফাঝা মায়। hira

ctg
.blog
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উক্যয ছটফক্ে পেখুন। চাটডটট টক্রক্ট র্াকা অফস্থায় পভনু পর্ক্ক Layout অন টক্রক্ট করুন। 
োযয টনক্চয ছটফয ভে Chart Title পর্ক্ক চাটড বয Title পেন। 
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োযয আফায Data Tables বয under পর্ক্ক Center টক্রক্ট করুন োক্র প্রক্েযকটা ফাক্যয 
ভান পেখা মাক্ফ। 
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র্াটা পটটফর পর্ক্ক টনক্চয অনটা টক্রক্ট করুন। োক্র টনক্চয ভে র্াটা পটটফর পমাগ ক্য় 
মাক্ফ। 
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োযয chart select কক্য design পভনুক্ে মান, অনয Chart layout select করুন, পেখুন 
chart অনযযকভ পেখা মাক্চ্ছ 

hira
ctg

.blog
spot.

com



    

 
আফায chart styles পর্ক্ক চাটড বয ফায গুক্রায style অনয যকভ ৩ টর্ ইক্পক্ট টেক্ে াক্যন hira
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Change Chart Type অন ব মান। 

hira
ctg

.blog
spot.

com



    

 
Bar chart পর্ক্ক পম পকান বকটা select করুন। 
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বই টছর পভাটাভুটট চাটড িটকডে কাজ।  

বখন আভযা Insert menu বয smart art options বয কাজ পেখক্ফা।  
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প্রর্ক্ভই আনাযা smart art ব টিক কযক্র বখাক্ন প্রচুয টযভাক্ন smart art বয পটভক্েট 
পেখক্ে াক্ফন। অক্নক ধযক্নয Hierarchy ফা Relationship ছটফয ভাধযক্ভ পেখাক্নায জনয 
টফটবন্ন ধযক্নয টর্জাইন আক্গ পর্ক্ক কযা আক্ছ, মা আনাযা শুধুভাত্র টিক কক্যই দেটয কযক্ে 
াযক্ফন। আটভ আনাক্েয বকটা hierarchy দেটয কক্য পেখাক্ফা বফ  আা কযক্ফা ফাটকগুক্রা 
আনাযা টনক্জযা পচষ্টা কক্য টখক্ফন। 
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উক্যয ছটফয ভে টক্রক্ট কক্য ok করুন। 
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উক্যয ছটফয ভে আক্ফ। উক্যয ছটফক্ে পমখাক্ন text পরখা আক্ছ পখাক্ন আটন টিক কক্য জা 
ইচ্ছা টরখুন। 
আটভ টরখায য টনক্চয ভে পেখাক্ফ 

 
 
আযক্মগুক্রা েযকায পনই, পগুক্রা ভাউ টেক্য় টক্রক্ট কক্য। Delete press করুন টকক্ফার্ড পর্ক্ক।  
 
োযয টনক্চ আক্যা shape পমাক্গয জনয প্রর্ক্ভ পাক্ভডট পরখা ফক্সটট টক্রক্ট কক্য menu পর্ক্ক 
add shape click করুন। টনক্চয ছটফয ভে নেুন ফক্স আক্ফ। 
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Right Click কক্য Edit Text পর্ক্ক পরখা াল্টাক্ে াক্যন ফা অনয টকছু টরখক্ে াক্যন। 

 
 
কারায টযফেডন বয েযকায ক্র পম পকান ফক্স টক্রক্ট কক্য উক্যয পভনু পর্ক্ক অনয যঙ টনফডাচন 
করুন। 
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োক্র আভাক্েয hierarchy টট টনক্চয ভে ক্ফ 

 
আটন মটে hierarchy বয layout টযফেডন চান োক্র অনয Layout পকভন রাগক্ফ ো select 
কক্য পেক্খ টনক্ে াক্যন। 
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আা কটয ফুঝক্ে পকান ভযা য়টন। আয ফাটক Smart Art বয পটভক্েট গুক্রা আনাযা বক্ক 
বক্ক টনক্জযা পচষ্টা করুন। আয পম পকাক্না layout টক্রক্ট কযায য কাজ কযায দ্ধটে প্রায় 
বকই যকভ। 

 

ভাইক্রাপট ওয়ার্ড টেক্য় টফটবন্ন ধযক্নয কাজকভড কযা মায়। মা য়ে আভযা অক্নক্কই জাটননা। 
আভায টকন্তু ms word খুফই টপ্রয় বকটা পটওয়যায। অফয শুধু ms word ফরক্র বুর ক্ফ। 
আটভ MS OFFICE PACKAGE টাক্ক খুফই ছন্দ কটয। আটভ অফয বটা ফরক্ফা না পম, আটভ পম 
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কাজ গুক্রা পেখারাভ বইগুক্রাই ফ ফা বই গুক্রা আনাযা আয অনয পকার্াও াক্ফন না, েক্ফ বটা 
ফরক্ফা পকউ মটে বই কাজগুক্রাই বারবাক্ফ আয়ে কযক্ে াক্যন োক্র োয আয Microsoft 
word বয অনয পকান কাজ জানায েযকায পনই। আয আটন মটে ms word বয basic tools 
গুক্রায কাজ বারবাক্ফ জাক্নন োক্র আটন Excel, Access, Powerpoint ইেযাটে 
পটগুক্রাক্েও অক্নক বটগক্য় র্াকক্রন। কাযন বগুক্রায formatting, styles ইেযাটে বকই 
যকভ। েক্ফ আটভ আনাক্েয আক্যা অক্নক কাজ আক্ছ পমগুক্রা পেখাক্ে াযরাভ না ফক্র েুঃটখে। 

েক্ফ Mailings, References & Review Tab গুরা বার কক্য পেখক্র, আনাযা টনক্জই বক্েয 
কাজ গুক্রা ফুঝক্ে াযক্ফন। পমভন Review Tab ব আটন াক্ফন আনায পরখাক্ে 
Gramartical পকান বুর র্াকক্র আটন পখান পর্ক্ক টিক কযক্ে াযক্ফন।  

বে েীঘড ভয় ধক্য ফইটট োয জনয আনাক্ক ধনযফাে। 

(কর প্রকায অটনচ্ছাকৃে বুর ও অাযেটডো পেু অস্বচ্ছোয জনয ক্ষভা পচক্য় টনটচ্ছ। গু্ীজন টনজ 

গুক্নই আভায বুরগুটর ক্ষভাুন্দয েৃটষ্টক্ে পেখক্ফন ব আাই যইর। ধনযফাে বার র্াকক্ফন কক্র)  

(ইন্টাযক্নট ক্ে  গৃীে) 
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